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Introduction

The Art and Craft of Storytelling
Congratulations!  By opening up your mind to other ways of looking 

at the story creation process, you’ve taken the first step on the way to 
becoming a better writer.  For that’s all Dramatica is—a software tool 
for writers of dramatic fiction.  Whether you’re writing novels or short 
stories, screenplays or stage plays, the story development process 
Dramatica leads you through has the single aim of improving your craft 
of storytelling.

This approach to story determines how a story is structured, which 
dramatic elements constitute a “perfect” story, and how those elements 
are best arranged in order to have the writer’s desired effect on an 
audience.

Due to Dramatica’s 32,768 possible storyforms—or combinations 
of these dramatic elements—there is no danger of a formula being 
imposed upon the writer.  What makes your story so unique is that 
you are telling it, your way, as only you can.  Looking at story from 
Dramatica’s point of view can actually free your mind from any formulaic 
approaches to storytelling you may have unwittingly absorbed from 
other sources.

As Dramatica deals with the pre-writing phase of story creation—
where the left brain organizes and outlines the pieces that make up a 
story—it primarily affects the framework of your story.  Your individual 
line writing—where the right brain roams free and unleashes the art of 
storytelling—can be as creative as ever.  We hope that with the input of 
Dramatica, your creative writing partner, it will be more so.

Be prepared for a little frustration.  Writing, and especially rewriting, 
is not easy.  Be prepared for insight.  Much of what Dramatica has to 
say about story will be new to you, or may challenge your previous 
knowledge or assumptions about storytelling.  But much of it will have 
a familiar ring, putting a fresh spin on some aspect of storytelling you 
already use in your writing.  Be prepared to have fun.  True, writing 
is work.  But work should be fun.  Do what you love, and success will 
follow.
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Novels
Dramatica is designed for developing stories of dramatic fiction, 

which includes both novels and short stories.  A main difference 
between the two forms is scope.  Novels can contain many characters 
and the progression of their activities over much space and time.  Short 
stories tend to concentrate on a smaller number of characters, perhaps 
on one dramatic incident in one place over a short timespan.

Whichever form you choose, the StoryGuide is a great place to 
start.  It leads you through the steps of developing your characters, 
creating a Storyform structure, and writing concrete examples in 
Illustrating.  

When it comes to the Storyweaving stage, short story writers will 
probably want to skip Exposition Development and jump straight into 
Scene Creation to shape the scenes that make up the short story.  For 
your Scene Labels, choose Scene.  After planning your scenes, print a 
Story Treatment Report and expand it into your short story.

Novelists, dealing with a much larger work of fiction, will want to 
take advantage of all the story pre-planning tools available.  Exposition 
Development gives you the opportunity to further develop your story.  It 
also provides you with a way to visualize your characters’ Introduction 
into, and Dismissal from, your story.  In Scene Creation, you’ll be using 
Chapter or Scene as your Scene Label.  The “This Scene Represents” 
pop-up menu will help you plan the threading of thematic elements 
through your throughlines.  Print a Storyweaving Overview Report to 
see how you’ve tied all the elements of your story together, scene by 
scene.  For a plain plot synopsis of your chapters and scenes, print the 
Story Treatment Report.

Scripts
The One-Act Play can be developed in a similar fashion to the short 

story, above.  For your Scene Labels, choose Scene.  
The screenplay and the longer two or three act stage play are more 

like the novel in their depth of storytelling.  As with novel writing above, 
both will benefit from the Exposition Development and Scene Creation 
stages of Storyweaving.  

The Stage Play has a visible organization into acts, traditionally 
indicated in the performance by the lowering and raising of the stage 
curtain.  Within each act are dramatic scenes.  For your Scene Labels, 
choose Scene.  
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The motion picture screenplay is structurally organized into a 
number of acts, though they are not readily apparent to the viewer 
of the finished film.  For your Scene Labels, choose Scene.  Print a 
Storyweaving Overview Report to see how you’ve tied all the elements 
of your story together, scene by scene.  For a full narrative treatment of 
your scenes, print the Story Treatment Report.

Television’s sitcom, episodic drama, longform MOW, and miniseries 
are organized into acts for the purpose of commercial breaks—the 
longer the story, the more acts it contains.  These acts build up to the 
breaks, and are designed to hook the viewer into staying through the 
commercials and staying with the story.  In Scene Creation, you’ll be 
using Scene as your Scene Label.  Print a Storyweaving Overview 
Report to see how you’ve tied all the elements of your story together, 
scene by scene.  For a full narrative treatment of your acts and scenes, 
print the Story Treatment Report.

Storyforming
Storyforming involves the natural process of thinking about a 

story before any writing begins.  This covers the creative, intuitive, and 
practical decision-making skills common to all writers and storytelling 
styles.  By brainstorming with Dramatica, you can develop the dramatic 
framework that incorporates the structural and thematic elements of 
your story.  The term Dramatica uses to describe this “deep structure” 
is a Storyform.  Working with Dramatica to determine the most suitable 
storyform takes your single idea and expands it into a cohesive story, 
rich with meaning.  

Dramatica contains 32,768 potential storyforms.  You could use 
any one storyform as the basis for telling your story, though each would 
have a different effect on the way an audience experiences that story—
due to its particular themes and the order in which they are revealed.  
Each storyform, however, contains the entire set of story elements 
needed to create a complete story.  

The number of potential storyforms is not the number of stories 
that have been or can be told.  The variety of illustrations through 
which each storyform can be dramatized is limited only by a particular 
writer’s imagination.  There is no limit to the number of stories which 
can evolve from a single storyform, much less from all 32,768 storyform 
combinations.  The object of storyforming in Dramatica is to find a single 
storyform that best incorporates the structural, thematic, and dynamic 
elements of your story.  Identifying this “one” storyform is done by 
choosing from a number of multiple choice topics.  
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Some topics have only two or three possible selections, others 
over sixty.  Making choices in one topic will have impact on other 
topics.  Sometimes the connections are obvious, other times obscure.  
Regardless of which topics you pick first and which last, going through 
the storyforming process will eventually lead you to that single storyform 
that best embodies the meaning and feeling of your story.

The Dramatica Query System (DQS), which includes the 
StoryGuide path, tackles storyforming in a traditional question and 
answer approach.  

The Story Engine approaches storyforming from a more holistic 
point of view, working behind the scenes to ensure your selections are 
consistent with the priorities you establish.  Choices made first have top 
priority, the second choice made has second priority, and so forth.  In 
this way the story engine guides (and is guided by) your efforts to find 
the best storyform for the story you have in mind.

Try both features.  They each have strengths and weaknesses, but 
between the two you’ll develop a storyforming approach that works for 
you.

Illustrating
Dramatica makes a clear distinction between two different phases 

of story creation:  Storyforming and Illustrating.  
Whereas storyforming is the process of creating a story’s dramatic 

skeleton, or structure, Illustrating is the process of fleshing out that 
skeleton.  Here, you illustrate your storyform choices with specific 
examples—in the form of description, dialogue, events, etc.—that can 
become portions of your finished story.  

Storyweaving—here, you can further develop your illustrating into 
more detailed story exposition.  Then, construct scenes that combine 
into a narrative treatment of your story (Scenes for a screenplay, Acts 
or Scenes for a stage play, Chapters or Scenes for a novel).  In the 
Scene Creation phase of storyweaving, you can also incorporate your 
story’s Signposts (indicators of where the characters stand at certain 
key points) and Journeys (dramatic acts between signposts) into a 
linear timeline for your story.  While doing so, you assign each of 
Dramatica’s story elements to one or more scenes, ensuring that they 
are represented throughout the story.

(Note:  Signposts and journeys are elements of Plot Progression.  
In the StoryGuide, they are used in the Level 3 path, but not the Level 1 
or Level 2 paths.)
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Dramatica Desktop

The Dramatica desktop is the first window that appears when you 
open Dramatica by double-clicking on its icon.  It has twelve tiles which 
make up a “launch pad” from which to begin developing your stories.  

Desktop Tiles
The tiles give you access to the most commonly used tools in the 

program.  Just click your mouse once on any tile to go to that feature of 
Dramatica.  

StoryGuide tile
The StoryGuide leads you step-by-step through the creation of 

your story.  Recommended for first-time users, and preferred by many 
seasoned Dramatica users.  

Help tile
Dramatica has an extensive Online Help system, complete with this 

manual and the Dramatica Theory Book.

Open Story tile
Open Story opens existing Dramatica story files.  You can open 
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your own files, or the detailed example files that are included with the 
software.

Character tile
The Character List window is where you create your story’s 

characters and establish dynamic relationships between them.

Plot Progression tile
Plot Progression view gives you a linear display of your story’s 

4 throughlines from beginning to end of the story.  Each throughline 
consists of 4 Signposts—indicating where the story stands at certain 
points—and 3 Journeys—the acts between the signposts.

Theme Browser tile
The Theme Browser displays a 3-Dimensional view of your story’s 

dramatic elements, giving a bird’s-eye look at how they interconnect.  
Recommended for Advanced users only.

Dictionary tile
To better understand the questions Dramatica asks, or the unique 

terms it uses, consult the Dramatica Dictionary.  With this floating 
dictionary, definitions are always just a mouse click away.

Query System tile
The Dramatica Query System offers several different approaches 

to creating your story.  While there’s less “hand-holding” here than in the 
StoryGuide, there are also more choices of where to start fleshing out 
your ideas.  

Story Engine tile
The Story Engine takes you to the structural heart of your story, and 

allows you to tweak your story choices and explore “what if?” scenarios.  
This way, you can see how the changing of one item ripples throughout 
your story and affects the other parts.

Story Points tile
The Story Points window offer another view of your story, a table 

of your story’s dramatic elements and the illustrations you’ve written to 
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illustrate them.  You can also edit your illustrations here.

Reports tile
The Reports window is where you view or print detailed reports on 

your story’s structure, characters, theme, plot, genre, and Illustrations.  
These reports can also be exported for use in Movie Magic Screenwriter 
or a word processing program.

Brainstorming tile
Have fun as Brainstorming puts a fresh spin on your story.  Based 

on your story choices so far, Spin-the-Model randomly fills in the rest 
to give you a storyform you might not have thought of.  The Character 
Generator creates new characters with as much random-ness as you 
allow.

The Dramatica Menu Bar

(Note:  There is also a Window Menu to the right of Tools.  This 
shows which Dramatica story file is open and, in Windows, options 
for arranging windows on the desktop.  In the Windows version only, 
there is also a Help Menu, displaying the Help and About Dramatica 
commands.  In the MacOS version, these commands are available 
under the  Menu at the left of the Main Menu bar.)

The Dramatica menu bar allows you to perform standard software 
operations such as file management and text editing.  In addition, the 
menu commands allow you to access all major features in Dramatica 
from any part of the program.

Under each heading in the menu bar is a menu of command 
options, as pictured above.  Any key command available in Dramatica is 
listed next to its corresponding menu command.  Most of these features 
are also available through the Dramatica Desktop and other tiles in 
various areas of the program.  

Generally, menu commands that have ellipses “…” after their name 
open a window or dialog box with further choices.  Commands that do 
not have ellipses after their name execute the command immediately.

File Commands
File commands are used for general document handling and, for 
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the most part, work the same as in other programs.  The Dramatica 
Desktop indicates which story file is open by displaying the file’s name 
in the desktop window’s title bar.  The File commands include:

 

New command
The New command creates a new, empty Dramatica story file 

called “Untitled”.  Dramatica automatically creates a new story file each 
time the program is started.

Open command
The Open command opens previously saved story files.  These 

may be files you created and saved, or the example story files shipped 
with Dramatica.

Close command
The Close command closes the current active window.  If the 

Dramatica desktop is the current active window, the currently active 
story file is closed also.  If the document needs to be saved, Dramatica 
prompts you.

Save command
The Save command saves changes to your story file.  If you do not 

want to overwrite your original story file, use the SAVE AS… and SAVE 
A COPY AS… commands.

(Note:  In addition to saving the changes you make to your story 
files, make sure that you occasionally make backup copies of your 
work to floppy disk, tape drive, or file server.  If some sort of hard disk 
or system problem occurs, you don’t want to lose the only copy of your 
work.)

Saving is a quick process and you should save often.  

Save As… command
The Save As… command saves a copy of your story file under 

a different file name.  You can make multiple versions of a work in 
progress by keeping separate drafts.

The original version of the story file is closed unchanged, and the 
new version of the story file is open and ready for you to continue your 
work.
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If you try to save as the same name as your original story file, the 
Save As… command may ask if you want to overwrite the existing file.  
If you answer yes, Dramatica will behave as if you had executed the 
Save command and overwrite your original story file.

Save A Copy As… command
The Save A Copy As… command differs from the Save As… 

command only in that the original story file is left open, while a copy 
(complete with changes) has been saved under a different name.  This 
command is particularly useful if you want to work consistently in one 
file, yet save a series of drafts as you work.

Export… command
Selectable only when you have the Reports window open, the 

Export command lets you save the contents of a Report to a text file.  
Exporting report text is especially useful as a transition from the story 
development stage (in Dramatica), to the writing and/or rewriting stage 
(in your word-processing software).  The text file(s) can then be opened 
in your word processing program and used to guide the writing/rewriting 
of your story.  

Export to Screenwriter… command
The Export to Screenwriter command lets you export much of your 

character work and Scenes/Acts/Chapters created in storyweaving to 
the Movie Magic Screenwriter software program.  

Print Preview… command
The Print Preview command lets you view a report onscreen 

before you print it, showing you the effects of your printing setup and 
preferences.

Page Setup… or Print Setup… command
The Page Setup command (MacOS) or Printer Setup command 

(Windows) controls general page options like image orientation, paper 
size, etc.

Print command
Selectable only when the Reports window is open, the Print 
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command sends the report displayed on-screen to the printer.

Exit/Quit command
The Quit command closes all open story files and exits from 

Dramatica.  If a story file has been modified since the last save, 
Dramatica will prompt you to save the file.  If you do not want changes 
made to your story to be saved, answer “No” to the save prompt. 

Edit Commands
The Edit commands primarily control text editing functions.  When 

edit commands are unavailable or inappropriate, they are dimmed on 
the menu, displaying in gray.  The Edit commands include:

Undo command
The Undo command cancels the last text editing operation 

performed.  

Cut command
To use the Cut command, first highlight some text by selecting it.  

Double-click on a word, or drag across a block of text.  When you cut 
the highlighted text, you permanently remove it from your story file and 
temporarily store it on the Clipboard.  Used with the Paste command, 
the Cut command is useful for moving sections of text around by 
“cutting” it from one place and “pasting” it into another.  

Copy command
To use the Copy command, first highlight some text by selecting 

it.  Double-click on a word, or drag across a block of text.  When you 
copy the highlighted text, it remains in your story file and a copy of it is 
temporarily stored on the Clipboard.  Used with the Paste command, the 
Copy command is useful for duplicating sections of text by “copying” it 
from one place and “pasting” it into as many other places as you want.  

Paste command
The Paste command is used to insert cut or copied text.  To use 

the Paste command, first put the cursor where you’d like the text to be 
inserted.  If the insertion point is a block of highlighted text, the Paste 
command will replace it with the text stored on the Clipboard.
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Clear command
To use the Clear command, first highlight some text by selecting 

it.  Double-click on a word, or drag across a block of text.  The Clear 
command permanently removes the highlighted text without storing it on 
the Clipboard.  It works similar to the Delete key on your keyboard, but 
on larger blocks of text.  Unlike the Cut command, the Clear command 
does not disturb text already stored on the Clipboard—allowing you to 
continue Pasting it into your story file.

Select All command
The Select All command selects and highlights all of the text in the 

currently active text window.

Preferences… command
The Preferences command gives you control over various general 

program and printing options, allowing you to customize Dramatica to 
work the way you work.  

General Preferences:

• Fast Save Enabled—If checked, the Fast Save feature is 
enabled for all story files.  This performs a quicker save, but 
only saves changes to the file.  If the size of the appended 
edits gets to be too big (> 20% of the original file size), then 
a full save is automatically done to reduce file size.  Enabling 
Fast Save makes the story file more susceptible to corruption 
in the case of a system crash.

 Unchecked, a complete save of the entire story file is 
performed each time the save command is issued.  Slower but 
safer.  Default is Unchecked.  

• Autosave—If checked, causes Dramatica to bring up a Save 
dialog every “n” minutes, based on the number in the Auto 
Save number box.

• Unchecked, you are not prompted to save your story files at 
regular intervals.  Default is to Autosave every 30 minutes.

• File Menu Can Open Multiple Stories—If checked, the 
File Menu can open more story files without first closing the 
currently open story file.  Unchecked, the currently open story 
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is closed before opening any other story file—only one story 
file may be open at any one time.

• Pronoun Gender In Examples—Select your preference 
of pronoun gender to use in the on-line tutorial—He, She, 
or It (neutral).  The proper gender will be substituted where 
appropriate.

 (Note: This is not the same as a character’s gender which is 
used when referencing either the Main or Impact Character.)

• Default Character Gender—Select a default gender to use 
when creating new characters—Male, Female, or Neutral.  All 
new characters (including the Main & Impact characters) are 
“born” with the default gender you select here.

• Save Character Pictures In Document—If checked, bitmaps 
of the character icons you’ve used are saved as “custom 
pictures” within the story file.  This makes the story file slightly 
larger.  Unchecked, a story file references Dramatica to display 
the selected character icons  With this option enabled, users 
of Dramatica Writer’s DreamKit can open a Dramatica story 
file and see the original icons (not all of which are available in 
WDK). 

• Characteristic Notes—Click on the pop-up menu to select 
either Append or Replace.  When importing a stereotyped 
character’s characteristics using the Typecast command, the 
Characteristic Notes are also transferred.  They can either 
replace the existing notes, or be added after the existing notes 
(appended).  If unsure, choose Append to get both sets of 
notes and later delete the ones you don’t want.

Report Options:

• Printing Margins—Enter values for your report margins—Top, 
Bottom, Left, and Right—adjustable in units of 1/100th of an 
inch.

• Number of Columns—Select from: 1, 2, or 3 columns of text 
in your report.

• Header—Enter the text, along with Substitution codes and 
Justification codes, for the headers in Dramatica’s printed 
reports.  Header text displays left-justified, unless you indicate 
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otherwise.

• Footer—Enter the text, along with Substitution codes and 
Justification codes, for the footers in Dramatica’s printed 
reports.  Footer text displays left-justified, unless you indicate 
otherwise.

Header/Footer Justification Codes

If you type: Your text is justified:

^< Left

^|  (“|” = shift-backslash) Center

^> Right
: 

Justification Codes affect the text directly to the left of them.  As an 
example, the default Dramatica footer text of:

Dramatica ^V^<- ^P -^|^D^>
     prints as:

Dramatica 4.0 - 1 -  Mon Jan 3, 13:12:35 2000

Header/Footer Substitution Codes

If you type: Dramatica substitutes:

^A or ^a Author of story

^D or ^d Date and Time

^P or ^p Page number

^R or ^r Report name

^T or ^t Title of story

^V or ^v Version number of Dramatica

^^ The caret character (^)

Query System Options:

• Advance to Next Question—Select which key you’d like to 
move you to the next question in the Query System:

 Enter—If selected, pressing Enter advances to the next 
question.  Pressing Shift-Enter creates a new blank line in the 
text window.  (On the Macintosh, use Return and Shift-Return.)
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 Shift-Enter—If selected, pressing Shift-Enter advances to the 
next question.  Pressing Enter creates a new blank line in the 
text window.  (On the Macintosh, use Return and Shift-Return.)

• Use Throughline Colors—If checked, the four throughlines 
of your story are each be displayed with a different identifying 
color background in the Query System (Overall = Pink, Main 
vs. Impact = Yellow, Main Character = Blue, Impact Character 
= Violet).  Unchecked, all throughlines appear with the same 
gray-colored background.

 Set Colors…—Click on this button to change the colors 
assigned to each of the 4 Throughlines and to the Quick Start 
StoryGuide.  The color for each throughline appears next to its 
name.  Click on the Set button to display a palette of available 
colors to choose from.  Choose a new color or create a custom 
color, using your operating system’s color controls.

• Toggle Help Buttons—Controls how a button in the HelpView 
window (Explain, Theory, Usage, etc.) behaves when another 
one (or more) is already selected:

 Click—Clicking on another button selects it instead of the 
currently selected button.  Only one button’s explanatory text 
displays in the HelpView window below the buttons at one 
time.  

 Shift-Clicking another button selects it in addition to the 
currently selected button.  The text for all the buttons selected 
appears in the HelpView window’s scrollable list.

 Click or Shift-Click—Either Clicking or Shift-Clicking another 
button selects it in addition to the currently selected button.  
The text for all the buttons selected appears in the HelpView 
window’s scrollable list.

• Auto-Close Items in Topic List—If selected, closes the 
currently open item in the hierarchical Topic List when you 
press Enter or Shift-Enter (Return or Shift-Return on the 
Macintosh) to advance to the next question in the Query 
System.  Unselected, each item in the topic list remains open 
after use.
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Term Swap Options

• Use Layman’s Terms—If selected, displays the new, easier to 
understand words for Dramatica concepts.  This is the default 
setting.

• Use Original Dramatica Terms—If selected, displays the 
original  words for Dramatica concepts.  You may prefer 
this setting if you are a power user of previous versions of 
Dramatica.

Set Font… command
The Set Font… command controls which font and font size is used 

to display:
• The Query System TOPICS LIST.

• The Query System PROMPTS and TITLES.

• The text you EDIT.

• The HELP text.
(Windows Users Note:  Use TrueType fonts whenever possible.  Non-
TrueType fonts frequently do not display or print as well in Dramatica.)

Storyforming Commands

There are five commands in the Storyforming menu:

StoryGuide
 The StoryGuide is Dramatica’s step-by-step “tutorial” for creating 

a story.  It’s specifically designed to give writers new to Dramatica one 
“ideal” path for approaching their story through Dramatica.  

The StoryGuide tutorial takes place entirely online.  It can be 
accessed in two ways:

• Under the Storyforming Menu, select StoryGuide.

• At the Dramatica Desktop, click on the StoryGuide’s Start 
Here tile.
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The StoryGuide window presents you with a choice of three paths 
to creating your story:  It’s not necessary to go through all three paths—
but if you do, all the work you do in one level appears in the others.

Level 1
Click on this button for the quickest path to creating a story.  

Though this path doesn’t utilize every element of the Dramatica model 
of story, you may find it contains enough to get you started on your 
story.  Writers of shorter dramatic stories, such as short stories, one act 
plays, and sitcoms will find plenty to work with here.

This path is designed to be followed from beginning to end, 
answering the questions in the order presented.  

All the creative work you do here shows up in the Level 2 and Level 
3 paths and in other parts of Dramatica.

Printing a report at each stage of the StoryGuide is optional, though 
it does provide a handy reference tool.

After responding to each question, press RETURN (MacOS) or 
ENTER (Windows) to advance to the next one.

The Level 1 StoryGuide path contains approximately 60 questions. 

Level 2
The Level 2 path helps you develop your story on a somewhat 

deeper level than the Level 1 path, mainly presenting more Main 
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Character and Theme development.
This path is designed to be followed from beginning to end, 

answering the questions in the order presented.  
All the creative work you do here shows up in the Advanced path 

and in other parts of Dramatica.
Printing a report at each stage of the StoryGuide is optional, though 

it does provide a handy reference tool.
After responding to each question, press RETURN (MacOS) or 

ENTER (Windows) to advance to the next one.
The Level 2 StoryGuide contains approximately 75 questions. 

Level 3
Click on this button to develop your story in  much fuller depth.  

All four throughlines are fully developed with their own Concerns, 
Problems, Themes, and Signposts & Journeys.  You are able to skip 
questions and answer them later, or even let Dramatica supply the 
answers based upon your other decisions, when possible.

All the creative work you do here shows up in other parts of 
Dramatica.

Printing a report at each stage of the StoryGuide is optional, though 
it does provide a handy reference tool.

After responding to each question, press  RETURN (MacOS) or 
ENTER (Windows) to advance to the next one.

The Level 3 StoryGuide path contains approximately 250 questions.   

Structure Templates
The quickest and easiest way to create a story in Dramatica is 

by opening a structure template and using the Level 1 path of the 
StoryGuide.  There are a number of templates to choose from, e.g., 
screenplay, novel, short story.  

Each comes with an appropriate number of archetypal characters 
already created, ensuring that each character has a clear dramatic 
function in the story.  If these characters are sufficient for the story you 
want to tell, just change their names and develop them as prompted.  
You may delete characters or create more as needed, but at a minimum 
you’ll need to keep the Main Character and Impact Character.

Other than having characters already created, the first three 
sections of the StoryGuide path—Getting Started, Storyforming, and 
Illustrating—are the same.  When you reach the Storyweaving section, 
you’ll notice the greatest difference.  
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A complete step outline has been constructed for you, presenting 
the story’s dramatic elements in an order suggested by traditional 
models of story structure.  You may be familiar with these elements from 
your previous writing studies.  Attached to each step are the Dramatica 
story points you created by answering questions in the Storyforming 
section, and the examples you wrote in the Illustrating section.

Each step may represent one or more scenes, depending on the 
needs of your story.  You may rearrange, add, or delete steps once you 
understand the Storyweaving section.  It is recommended that you print 
the Story Treatment first, to have as a reference.

The title of each step indicates the dramatic function of that step, 
and explanatory text within each step tells you what to write about in 
each scene.  You may delete this text, overwrite it with examples that 
you copy and paste from the lower text window, or leave it in the step to 
remind you of the step’s dramatic function.

Bear in mind that these are example story structures, and may 
not fit every story that you have in mind.  For example, the screenplay 
template tends to favor the commercial Hollywood film—it’s a good fit 
for the love story, romantic comedy, buddy movie, and action adventure 
genres.

To use a structure template:

1. At the Dramatic Desktop, click on the Open Story tile.

2. At the dialog box that displays, select a template to open, e.g. 
Novel.

3. When the Dramatic Desktop displays again, Novel Template 
displays in the top title bar.  Click on the StoryGuide tile.

4. Choose a path and click on its button, e.g., Level 1.

5. Under the File menu, click on Save As to save the file under a 
new name for your story, e.g. MyStory.

6. Start creating your story! 

Query System (DQS)
The Dramatica Query System (DQS) employs a question and 

answer approach to Storyforming.  
The primary strengths of the DQS include:
• Focus on one item at a time, reducing confusion.
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• Step by step guidance through Storyforming, Illustrating, and 
Storyweaving.

• Plentiful support material available in the HelpView portion of 
the DQS window.

• Multiple approaches to storyforming.
The principle advantage of the DQS—focusing your attention on 

one topic at a time—is also one of its weaknesses.  It allows you to 
make selections without presenting a lot of extra, confusing material.  
Unfortunately, this doesn’t help you get an overall sense of the impact 
your selections have on the rest of the storyform.  (For a more holistic 
method of storyforming, see the section on the Story Engine command.)

Access the DQS using one of these methods:
• Under the Storyforming Menu, select Query System.

• At the Dramatica Desktop, click on the Query System tile.
(Note:  The StoryGuide command also invokes the DQS, though 

it uses a specialized topic path specifically designed for new users of 
Dramatica.)

Query System… command
Selecting Query System takes you to the Query System Home 

Window.  Choose one of the Topic Paths as a starting point for 
answering Dramatica’s questions by clicking on its button.  

The blank bar under each button is a progress indicator.  As you 
complete questions in each topic path, the bar fills in to show how much 
of the total story development you’ve completed.
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For a new story, you should proceed in the order the topics appear 
onscreen, from the top down:

1. Storyforming (to create the underlying structure)

2. Illustrating (to give concrete examples from your story)

3. Storyweaving (to place your structure and illustrations into 
scenes)

Whichever topic you start with, you’ll eventually complete all three 
topics—resulting in a fully developed Dramatica story.

Within each of these Topics, select which area of your story you’d 
like to start working on first:

a. Character

b. Plot

c. Theme
These can be approached in any order.  Again, whichever one you 

start with, you’ll be doing the others later.  
Clicking on a button brings up that topic in the topic window at the 

left of the screen.  For example, clicking on Storyforming/Character 
brings up a hierarchical list of questions regarding your Main and Impact 
Characters.  Once you’ve completed them, you’re returned to the Query 
System Home Window to choose your next topic path.

In Storyforming, you are presented with multiple-choice questions 
about your storyform.  In Illustrating, you are presented with fill-in text 
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windows in which you illustrate those answers with events, dialog, or 
just ideas you can expand on later.

Navigating the Query System
Use these features to navigate the Query System window:
• Press ENTER (Win) or RETURN (MacOS) to move to the next 

topic.  (also hold down the Shift key, if you have made that your 
Preference in Keyboard Options.)

• Click on the Previous and Next buttons in the lower left hand 
corner to move up or down the current topic list.  

• Click on a topic in the list to move directly to it.

• Click on the Start button to go to the first topic in the currently 
selected part of the Query System (such as Quick Story, Story 
Points, etc.).

• Click on the Close button to exit the Query System and return 
to the Dramatica desktop.

Topics List Tree
The Topics List in the upper left hand corner of the DQS window 

shows you which topics are in the currently-selected path.  
To change paths, select one from the Topic Pathways Pop-up Menu 

located just above the topics list.  Click on the Home button to return to 
the Home window.

The topics list displays as a hierarchical tree.  Each topic heading 
can be expanded to show the items nested beneath it, and collapsed to 
hide them.  

The look and feel of the topics list are slightly different under 
Windows and MacOS:

Windows Topics List
The tree works in a similar fashion to Windows 95’s Explorer 

program.  
• Clicking on the `+~ symbol expands the topic heading and 

displays all the items beneath it.

• Clicking on the `-~ symbol collapses the topic heading and 
hides all the items beneath it.

• Pressing ENTER or œ to go to another topic automatically 
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collapses the current topic heading’s items and expands the 
next one’s.

MacOS Topics List
The tree works in a similar fashion to the MacOS’s hierarchical 

menus and folders.  
• Clicking on the 4 symbol expands the vocabulary heading and 

displays all the items beneath it.  

• Clicking on the 6 symbol collapses the vocabulary heading 
and hides all the items beneath it.

• Pressing ENTER or RETURN to go to another topic 
automatically collapses the current topic heading’s items and 
expands the next one’s.

Storyforming in the Query System
The Topics List in the upper left hand corner of the Storyforming 

DQS window shows you what questions are in the currently-selected 
path.  

To change paths, select one from the Topic Pathways Pop-up 
Menu located just above the topics list.  Click on the Home button to 
return to the Home window.

Multiple Choice Storyforming Questions
The Storyforming DQS window presents questions that have 

a direct impact in creating your story’s dramatic skeleton or deep 
structure.  Some DQS questions are multiple choice, asking you to 
choose between two options—or to choose “Skip this question for now” 
if you’re not sure of the answer yet.  

Radio Button style of making DQS choices

To choose an answer, click on the radio button (also known as an 
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option button) or on the text of the answer itself.

Multiple Word Storyforming Questions
Other DQS questions require you to select from a multiple word list.  

Depending on other questions you’ve answered, there may be as many 
as 64 items to choose from.  If you’re not sure which item is exactly 
right for your storyform, select all the ones you think might fit.  Later 
questions will help narrow down your choices to one answer.

Multiple Word style of making DQS choices

To select an item listed in the leftmost window, highlight it by 
clicking on it.  Next, click on the ADD>> button to move it to the 
rightmost window.  Repeat this procedure for all the items you want to 
select.  

If you change your mind about an item you’ve added to the 
rightmost window, highlight it by clicking on it.  Then click on the 
<<REMOVE button to remove it and send it back to the leftmost window.

Illlustrating in the Query System
The Topics List in the upper left hand corner of the Illustrating 

DQS window shows you what questions are in the currently-selected 
path.  

To change paths, select one from the Topic Pathways Pop-up 
Menu located just above the topics list.  Click on the Home button to 
return to the Home window.

Fill-in Text Window Illustrating Questions
Illustrating DQS topics are presented with fill-in text windows 

in which to write your answers.  Your answers should give concrete 
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examples of how you are going to illustrate your storyform choices while 
telling your story. 

Illustrating DQS Fill-in Text Window

In each Illustrating fill-in text window, try to keep your material 
to a maximum of one or two pages.  In fact, the shorter the better.  
Dramatica is designed as a place to develop your story, not write it.  
Keeping the illustrations to a minimum will ensure that you can make 
your story point, while reducing the need for extensive reworking.

Text Editing in the Query System
As Dramatica deals with the story development, pre-writing phase 

of your story, the text editing capabilities of the DQS Illustrating window 
are limited.  

First, highlight the text by double-clicking on a word or dragging 
over a block of text.  Then:

Copy Text

• Under the Edit Menu, select Copy.

• On the keyboard, press CONTROL+C (Win) or CMD+C 
(MacOS).

Cut Text

• Under the Edit Menu, select Cut.
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• On the keyboard, press CONTROL+X (Win) or CMD+X 
(MacOS).

Paste Text

• Under the Edit Menu, select Paste.

• On the keyboard, press CONTROL+V (Win) or CMD+V 
(MacOS).

Save command

• Under the File Menu, select Save.

• On the keyboard, press CONTROL+S (Win) or CMD+S 
(MacOS).

Save your work frequently.

HelpView in the Query System
Both Storyforming and Illustrating DQS windows have a HelpView 

area with buttons running horizontally across the top.  These HelpView 
buttons give you access to different kinds of onscreen help regarding 
the Dramatica theory and the questions being asked.  

Click on a button to see the help text associated with it.

 

HelpView portion of the DQS window

The help text beneath these buttons is context-sensitive help, 
meaning that it relates to the specific question being asked.

Each button’s text relates to a different aspect of the Dramatica 
theory, and its application to your storyform:

• Explain button—provides a detailed description of what each 
topic is really asking from a dramatic standpoint.  

• Theory button—explains the dramatic reasons why each 
topic is important to your story and how it impacts other topics 
structurally.  
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• Usage button—sometimes describes how the dramatic issue 
being dealt with in each topic can actually be used in story 
construction.  Other times, Usage provides examples of how 
the dramatic topic was used in well-known stories.

• Illustrations button—calls up any illustrating you may have 
done for this topic anywhere else in the software.  In this 
manner you can refer to or revise what you have previously 
developed for each dramatic item.

• Help button—provides instructions on using the software in 
regard to each particular kind of screen.

• Definition button—gives a dictionary-style definition of the 
Dramatica terms you have highlighted in each topic screen.  
Information includes a short definition, a list of synonyms, and 
a long definition.

• Context button—uses a dramatic term you have highlighted in 
several dramatic scenarios, to show how it might be best used 
in your story.

• Stories button—calls up all stories in the Examples folder 
which share the same dramatic item you have highlighted.  In 
this way, you can see how a number of different stories use the 
same dramatic item—clarifying its use and purpose.  (Note:  
Although over 60 example stories are available, with 32,768 
possible storyforms not every item will have a matching story 
example.)

(Note:  Many of these HelpView buttons require you to make a selection 
and answer questions before they can provide definitions and help.)

Activating Multiple HelpView buttons
It’s possible to have more than one HelpView button active at 

once.  When more than one button is active, the text for each help topic 
displays in a list in the HelpView window.

To activate multiple HelpView buttons, hold down the ß key while 
clicking on each one.  

Resizing the HelpView window
The HelpView window can be enlarged, to enable viewing of more 

of the text.  The tradeoff is that the question windows above it reduce in 
size to make room for it.  
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• To resize the HelpView window:

1. Move the cursor over the thin resize bar just above the 
HelpView buttons (but not over the split diamond-shaped 
symbol on the far right).  The normal arrow cursor changes to 
a split diamond-shaped resize cursor.  

2. To select the resize bar, hold down the mouse button.  

3. Slide the bar upwards to enlarge, and downwards to reduce, 
the HelpView window.

• To toggle the HelpView window between open and closed—
showing or hiding the HelpView text—click once on the split 
diamond-shaped symbol on the far right of the resize bar.  Or, 
press CONTROL+H (Win) or CMD+H (MacOS).

Story Engine
Story Engine is recommended for Advanced Users Only.
Unlike the Query System and the StoryGuide, the Story Engine 

employs a simple window containing twenty-four different pop-up menus 
of storyforming choices.  However, they are all really different views of 
the same storyform material.  The story work you do in one view shows 
up in the other two.

Advantages of the Story Engine include:
• A holistic approach that shows the impact of your selection on 

other parts of the storyform immediately.

• A direct, non-linear way to select topics.

• The fastest method to reach one storyform.
The principal disadvantage of using the Story Engine is its lack 

of help.  The Story Engine offers only simple definitions of terms and 
prevents other help being accessed while it’s active.  For this reason, it’s 
more appropriate for the experienced Dramatica user.

Story Engine… command
Access the Story Engine using one of these methods:
• Under the Storyforming Menu, select Story Engine.

• At the Dramatica Desktop, click on the Story Engine tile.
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The Story Engine Window

Pop-up Topic menus
Click on a pop-up menu to display all of the available choices for 

that question.  Make a selection and the story engine will begin its 
magic.  

• Story items that have all of their options available will display 
the word Either or Any.  

• Items whose options have been limited will indicate the number 
of potential selections remaining, e.g. Any of 4.  

• Items which have been chosen indirectly by Dramatica based 
on other choices will display the name of the item in italics, e.g. 
Activity.

Click on another element in the list to make that your selection.
Click on Any or Either to deselect your choice and leave the Topic 

unanswered.

Storyforms Remaining
As you make a single choice—your story’s Throughline, for 

example—notice that the number of potential storyforms remaining 
(displayed screen-right, above the Clear button) decreases.  

If you select a Character Dynamics choice (for example, Do-er as 
the Approach), the number of potential storyforms decreases from the 
maximum of 32,768 to 16,384.  
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If you choose only a Thematic Choice (for example, Main Character 
Critical Flaw), the storyforms remaining immediately drops from 32,768 
to 512.  

Keep in mind that your goal is to reach the single storyform which 
best reflects the story you want to tell.  Each decrease in storyforms 
remaining is a step closer to your goal.

Locks
To the right of each topic is a “padlock” checkbox.  Click on this 

checkbox to “lock” your Topic selection, identifying it as a high priority 
choice. 

When a topic is locked, there is an “X” or check-mark in the padlock 
box.  You can remove this “X” by clicking on it at any time.  

Topics you have locked do not change when you issue the Clear 
Storyform command (see below).  Unlocked topics will be cleared, 
displaying “Any” or “Either” instead of your selection (unless they are 
limited by other locked topics).

Clear command
The Clear command is useful for testing various “what if?” 

scenarios for your storyform: 
1. Lock those topic selections that you’re most confident fit your 

storyform, then select some others (that you’re less sure of) 
without locking them.  

2. If the selections Dramatica predicts for you don’t fit your story, 
clear the choices you’re unsure of by clicking on the Clear 
button.  Your locked selections remain the same.  

3. Try again using different selections for the topics you’re unsure 
of, until you get a storyform that best suits your story.  

Clicking on the Clear button clears all storyforming choices you 
have made in the Story Engine (and in the Query System), except for 
ones you have selected and locked.  

If you clear your storyform then change your mind, you can go back 
to the storyform as it was before opening the Story Engine window by 
clicking on the Revert button.  

Any illustrating you have done is unaffected by the Clear Storyform 
command.  
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Revert command
The Revert command is like an “Undo” button for the Clear 

Storyform command.  It replaces your current storyform with the 
storyform as it was before opening the Story Engine window.  

Exit the Story Engine
OK—Click on this button to exit the Story Engine and keep changes 

you’ve made in this window.
Cancel—Click on this button to exit the Story Engine and discard 

any changes you made to the storyform in this window.  
(Note:  Based on choices you have made, the Story Engine will 

seem to answer other questions all by itself.  As you select the dramatic 
items for each question, Dramatica’s predictions show up in italics 
next to the questions you haven’t answered yet.  This helps you get an 
overall feel for your story, but since there is very little help text you might 
want to stick with the Query System until you are more familiar with 
Dramatica’s terminology.)

Clear Storyform…
Like the Clear button in the Story Engine window, this command 

clears all the Storyforming choices in the currently displayed story file.  
The Story Engine resets to 32,768 available Storyforms.

Unlike in the Story Engine window, there is no revert command 
available on Dramatica’s Main Menu Bar.  Dramatica prompts you to 
confirm your irreversible decision to clear the storyform.

Build Story Examples
This command updates the Dramatica Story Examples file to 

include all stories located in the Examples folder.  
If you add story files to the Examples folder and run this command, 

those stories will become available as story examples in the DQS 
HelpView window.  

Once launched, this command takes about two minutes to complete 
and should not be interrupted.



36.

Character Commands

In Dramatica, characters are not just “people who do things in a 
story.”  Each character serves a larger purpose by reflecting specific 
activities or attributes which are key steps in the story’s problem-solving 
process.

The Character commands are used to create, develop, and remove 
characters from your story.  The Character commands include:

Character List…
The Character List… command brings up a list of your story’s 

characters and a series of tiles for accessing more character features.  
Access the Character List using one of these methods:
• Under the Character Menu, select Character List…

• At the Dramatica Desktop, click on the Characters tile.

 
Character List Window
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When you first open this window in a new storyform, there are two 
icons in your character list.  The Main and Impact Character icons are 
created automatically with every new file in Dramatica.  The rest of your 
characters are created here by using the Create Character command.

The following tiles in the Character List window connect you to 
Dramatica’s character development tools:

Create Character…
Click on this tile or select the Create command under the Character 

menu to add a new character to your story’s character list.  Clicking 
here calls up a new Character Info window (see Info… command).  In 
this window, name your new characters, describe who they are, and 
describe what their roles in your story will be.

Build Characters…
Click on this tile in the Character List window or select Build 

Characters under the Characters menu to open the Build Characters 
window.  

Build Characters Window
In this window you can begin to develop your characters and 

their relationships with each other.  Do this by deciding what is driving 
them in your story.  The Character Element Grid of items in the center 
represents all of the possible characteristics (or elements) for your story.  

Assign Characteristics
Assign a characteristic to a character by:
1. Clicking on a character icon in the left window and dragging it 

over the Character Element Grid in the center.  

2. Once the icon is over a characteristic, text in the definition 
window above the grid changes to a context-sensitive 
description of the character with the associated characteristic.

3. Drop the icon onto a characteristic by releasing the mouse 
button.

Any character icon already assigned this particular characteristic is 
replaced by the one you dragged and dropped.



38.

Remove Characteristics
Remove a characteristic from a character by:
1. Clicking on the character’s icon on the Character Element Grid 

and dragging it off the grid to another part of the window.

2. Release the mouse button and the characteristic is removed.

Characteristic Notes
At the bottom of the Build Characters window is the Characteristic 

Notes window.  Use this text box to illustrate how a character fits the 
characteristic you’ve assigned to him or her.

The Characteristic Note stays with the characteristic, not 
the character.  If you remove a character icon from a particular 
characteristic, you need to also remove the Characteristic Note by 
deleting its text.

Character Dimensions
The relative position of two characters’ icons in the grid tells you 

something about the relationship the characters have in your story:

Characters diagonally opposed to each  
other have the greatest conflict.  

Characters next to one another  
have the most indirect impact  
on each other.  
 

Characters above and below 
 each other form positive  

or negative dependencies.  

Only one character icon can be assigned to 
each characteristic in the software.

Character Type
To identify a character as a particular Archetype, first select the 

character’s icon by single-clicking on it in the Character List window at 
left.  Then select the appropriate Archetypal designation (Protagonist, 
Reason, Skeptic, etc.) from the Character Type pop-up menu.
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To call up a character’s Character Info window, double-click on that 
character’s icon in the Character List at left.

Typecast
To give a character a set of characteristics associated with a certain 

character stereotype:
1. Select a character icon in the Character List window by double-

clicking on it.

2. Click on the Typecast button.  A Typecast Dramatica Character 
dialog box displays.

3. In the Look in: pop-up menu, open the Character Examples 
folder.

4. Assign the stereotype (bully, charmer, coward, etc.) of your 
choice by double-clicking on it.

If the characteristics of the stereotype conflict with other choices 
you’ve already made, you are prompted to replace your other choices.  
Characteristic Notes are also transferred, and either add to or replace 
the existing notes, depending on your Character Options settings.

Delete Character…
Deleting a character is a permanent, irreversible action.  To remove 

a character from your story:
1. Click on the character’s icon in the Character List window to 

select it.  

2. Click on the Delete Character tile or select Delete from the 
Character menu.  You are prompted to confirm your decision to 
delete a character.

The character is removed from the Character List and from every 
characteristic you assigned it to in the Character Element Grid of the 
Build Characters window.  However, all references to this deleted 
character remain in your Illustrations, if you wrote about the character 
there.

Warning!  Deleting a character removes it from everywhere it 
appears in your storyform.  You will lose all descriptions you may have 
written about it, and it will no longer appear in any of the reports.  Once 
it is gone, you cannot call back that information.  

(Note:  You must have both a Main and Impact Character in your 
storyform.  If you try to delete either of them from your story, you will be 
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prompted to reassign the Main or Impact Character function to some 
other character first.)

Character Info…
The Character Info window allows you to enter, review, and edit 

information—such as name, role in the story, description, gender, 
etc.—about a character.  To call up the Character Info window, use one 
of these methods from the Character List window:

• Click a character’s icon to select it, then press the Character 
Info tile.  

• Click a character’s icon to select it, then select Info under the 
Character Menu.

• Double-click on the character’s icon.  

 
Character Info Window

The Character Info window also allows you to assign or change a 
character’s icon.  Clicking on the `<<~ and `>>~ buttons beneath the 
image in the upper left hand corner of the window cycles through the 
available icons.  Choose an icon that reminds you of your character.  

(Note:  It is easier to assign icons to your characters in the Casting 
window.)
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Characteristics list
Below the character description text box is a non-editable list of 

the characteristics you assigned to the character in the Build Character 
window.

More… button
Pressing the More… button displays a window where you can enter 

more detailed information about a character.  This includes an expanded 
description of the character’s role, a description of the character’s 
function in the story, and a description of the type of activities with which 
your character is involved in the story.

 
More… Character Info Window

Closing the More… Character Info Window returns you to the 
character’s Info Window.

Setup Main and Impact…
The Main/Impact window offers a direct way to storyform using 

your Main and Impact characters.  It looks like, and operates in a similar 
fashion to, the Story Engine.  One advantage of storyforming here is 
that you can immediately see the impact of choices you make for one 
character upon the other.  

Display the Main/Impact Character window using one of these 
methods:
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• Click on the Main/Impact tile in the Character List window.

• Under the Character Menu, select Setup Main and Impact…  

Main/Impact Window

Though you cannot reach a single storyform just by making choices 
in the Main/Impact window, you can get very close.  

Pop-up Topic menus
Click on a pop-up menu to display all of the available choices for 

that topic.  If you haven’t made any storyforming choices elsewhere 
in Dramatica, there may be as many as 64 choices in some pop-up 
menus.  As you make choices, your range of choices will narrow.

Click on a story element to select it.  It is displayed as your 
choice in the pop-up menu, and a checkmark displays next to it in the 
list.  Dramatica chooses certain other topic elements based on your 
selection.  These are displayed in italics, e.g., Certainty.

Click on another element in the list to make that your selection.
Click on Any or Either to deselect your choice and leave the topic 

unanswered.

Clear button
The Clear Storyform command is useful for testing various “what 

if?” scenarios for your storyform: 
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1. If the selections Dramatica predicts for you don’t fit your story, 
clear the choices you’re unsure of by clicking on the Clear 
button.  Your locked selections remain the same.  

2. Try again using different selections for the topics you’re unsure 
of, until you get a storyform that best suits your story.  

Clicking on the Clear button clears all storyforming choices you 
have made in the Main/Impact Window (and in the Query System).  

If you clear your storyform then change your mind, you can go back 
to the storyform as it was before opening the Main/Impact window by 
clicking on the Revert button.

Any illustrating you have done is unaffected by the Clear Storyform 
command.

Note:  If some items remain selected even after you click on the 
Clear button, this means some choice have been locked in the Story 
Engine.  Go to the Story Engine, unlock the locked items, and issue the 
Clear command from there.

Revert command
The Revert command is like an “undo” button for the Clear 

Storyform command.  It replaces your current storyform with the 
storyform as it was before opening the Main/Impact window.  

Exit the Main/Impact Window
OK—Click on this button to exit the Story Engine and keep changes 

you’ve made in this window.
Cancel—Click on this button to exit the Story Engine and discard 

any changes you made to the storyform in this window.  
(Note:  Based on choices you have made, the Main/Impact Window 

will seem to answer other questions all by itself.  As you select the 
dramatic items for each question, Dramatica’s predictions show up 
in italics next to the questions you haven’t answered yet.  This helps 
you get an overall feel for your story, but since there is very little help 
text you might want to stick with the Query System until you are more 
familiar with Dramatica’s terminology.)

Casting…
Casting offers a simple way to assign icons to your characters.  

Choose an icon that reminds you of your character.  
To display the Casting window, click on the Casting tile in the 
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Character List window or select Casting… under the Character Menu.  

 
Casting Window

For ease of use, Character Icons are grouped according to type.  
When you find an icon that looks like the character you have in mind:

1. Click on the character’s current icon in the Character Icon list 
on the left side of the window.  

2. Scroll through the images in the category that best describes 
each character.  

3. Click on an icon to assign it to your character. 
The character’s icon will be replaced with the new one.  You can 

change icons at any time.  

Picture…
Across the bottom of the Casting window is an area for adding and 

grouping your own customized character icons.
Assign your own icons to your characters by using the Picture… 

command under the Character Menu.  
The Picture command can open Windows bitmap (.BMP) files in 

Windows, and PICT and PICT2 files on the Macintosh.
To import a character icon using the Picture command:
1. Click on the character’s current icon in the Character List 

window to select it.

2. Under the Character Menu, select Picture…  The Select 
Character Bitmap window displays.
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3. Select the picture file to import and click on Open.
Pictures are imported as 32 x 32 pixel character icons.
An alternative to using the Picture command is the Cut and Paste 

method:
1. Open the program or window where the picture you want 

resides.

2. Copy the picture you want to import to the clipboard, using the 
Copy command (CONTROL + C for Windows, CMD + C for 
MacOS).

3. In Dramatica, click on a character icon in the Character List 
window to select it.

4. Paste the picture from the clipboard, using the Paste command 
CONTROL + V for Windows, CMD + V for MacOS).

To delete a custom character icon:
1. Highlight the character icon by clicking on it.  

2. Press the DELETE key.

Import…
The Character Import command copies all of a character’s 

attributes (name, gender, role, icon, characteristics, etc.) from a 
Dramatica character file of your choice to a new character in the 
currently open Dramatica story file.  You can import the deliberately 
stereotypical characters (bully, optimist, screamer, etc.) that Dramatica 
supplies, or import from a character file created with the Character 
Export command.  

A character can be imported into any currently open Dramatica 
story file.  You can import a character while in any area of Dramatica, 
such as the desktop.  To Import a character:

1. Open the Dramatica story file you want to import a character 
into.

2. Under the Character Menu, select Import.  The Import 
Dramatica Character dialog box displays.

3. Double-click on the Dramatica Character File to import, e.g., 
Optimist.dcf.  (If the Import Character’s characteristics conflict 
with selections you’ve already made for other characters, you 
are prompted to make changes.)
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4. Under the Character Menu, select Character List.  The 
character you imported is now part of your cast of characters.  
Customize the character name, icon, description, etc. as 
desired.

You can also Import a Character by using the Open command:
1. Open the Dramatica story file you want to import a character 

into.

2. Under the File Menu, select Open.  The Open Dramatica Story 
File dialog box displays.

3. In the Files of type pop-up menu, select All Files.

4. Double-click on the Dramatica Character File to import, e.g., 
Optimist.dcf.  (If the Import Character’s characteristics conflict 
with selections you’ve already made for other characters, you 
are prompted to make changes.)  Dramatica displays a dialog 
box telling you that a character file has been imported.

5. Under the Character Menu, select Character List.  The 
character you imported is now part of your cast of characters.  
Customize the character name, icon, description, etc. as 
desired.

(Note:  The Typecast feature is similar to Character Import, 
using the stereotype characters in the Character Files folder.  The 
difference is that Typecast only adds the Characteristics (from the 
Character Elements Grid of Build Characters) of the character, and 
adds them to a selected character instead of creating a new character.  
Characteristic Notes are also transferred, and either add to or replace 
the existing Notes, depending on your Character Options settings (see 
Characteristic Notes on page 17.))

Export…
The Character Export command makes a copy of a selected 

character, complete with all attributes (name, gender, role, icon, 
characteristics, etc.), and transfers it to an external character file.  The 
character can then be imported into any Dramatica story file.  

Characters can be exported from:
• The Character List window.

• The Build Characters window.

• The Casting window.
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To Export a character:
1. In the appropriate character window, select a character icon by 

clicking on it.

2. Under the Character Menu, select Export.  The Select Name 
For Character File dialog box displays.

3. Enter a name for the Dramatica Character File you’re creating.

4. Click on the Save button.  
In Windows, this Dramatica Character File is given a file extension 

of .dcf.  
Dramatica Character Files are kept in the Character Examples 

folder.

Storytelling Commands

In Storyforming you decided which combination of dramatic 
elements would make up your story.  Now you’ll show how those same 
dramatic elements are played out in your story, in the part of story 
development that Dramatica calls Storytelling.

While most of this work is done in the Query System, Dramatica 
has a few extra commands designed to supplement your storytelling 
abilities.  Commands found in the Storytelling Menu include:

 
A special note should be made at this point about Dramatica’s 

Reports feature.  The reports are designed to put your storyforming and 
illustrating work into various contexts in order to provide greater clarity 
and understanding, and provide a reference to keep you on track as you 
do the line writing of the story.

Story Info…
The Story Info window helps you keep track of separate versions 

and drafts of your story.  You can enter basic information about your 
story here when you create a new file.  Later, when you reach the 
Illustrating stage of story development, you can refine that information in 
the illustrating part of the Query System.  The Query System offers the 
help in answering these questions that the Story Info window doesn’t.
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To display the Story Info Window, select Story Info… under the 
Storytelling Menu.

 
Story Info Window

After you fill out Story Info, you may notice that your story’s title 
appears automatically within appropriate Query System questions.  
Conversely, there are also areas in the DQS where you can input Story 
Info.  This data will be automatically displayed in the Story Info window 
as well.

Dramatica’s Reports take information from the Story Info window to 
place in header and footer text, using Substitution Codes.

Comments…
The Comments… command provides a place for you to enter any 

comments on your story and/or the story file itself.  

 
Comments Window
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When creating stories, use the Comments feature as a place to 
note general ideas, indicate the work’s state of progress, intended 
audience, and so forth.  

When analyzing stories, use the Comments feature to remark on 
the story’s strengths and weaknesses, as well as the strengths and 
weaknesses of the analysis itself.  In short, the Comments feature is a 
place to put thoughts, ideas, and observations about the story but not in 
the story.

Reports…
The Reports… command lets you output all the story work you’ve 

done in storyforming and illustrating.
Dramatica’s reports reflect your story elements from various 

perspectives, including your Overall and Main vs. Impact throughlines, 
your Main and Impact Characters, and your story as an entire work.  

Dramatica’s Reports help you take a broad overview of your story’s 
dramatics or focus on specific story points as you write.  

The reports can also be exported to your word processor as text 
files for further expansion or formatting.  If you’re creating a screenplay 
or stage play, character and scene work can be exported directly into 
scenes in Movie Magic Screenwriter.

In the Reports window you can read, print, or export a variety of 
reports about your story.  Before you can use most of these reports, you 
need to have arrived at a single storyform for your story.  

Access the Reports window using one of these methods:
• Click on the Reports tile on the Dramatica desktop.

• Under the Storytelling Menu, select Reports…
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Reports Window

Select a Report
To select a single report:
1. Click on the Vocabulary, Illustrations, and Show blank lines 

buttons, as desired (see below).

2. Click on the Select Reports pop-up menu at the top right of the 
Reports window.  

3. Holding down the mouse button, scroll through the list of report 
Categories.  When the cursor is over each category, a list of 
available reports branches off from it.  

4. Move the cursor sideways until it’s over a list of reports.  Click 
on a report name to select it.  The text of the report displays 
in the large Reports Reference Box below the pop-up menu, 
replacing any report text already there.

To read a description of each report’s contents, click on the Report 
Sets tile and view the Choose Report table.

To send the selected report to the printer, click on the Print tile.

Reports Window buttons

Vocabulary button
If selected, a vocabulary list is added to the end of the currently 

displayed report or report set, defining key Dramatica terms used in the 
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report.  When this button is selected by clicking on it, it appears set back 
or “pushed in.”  

Illustrations button
If selected, any illustrations you have done for topics that appear in 

the currently displayed report is also displayed and printed.  When this 
button is selected by clicking on it, it appears set back or “pushed in.”  

Show blank lines button
If selected, this option displays any section of consecutive 

blank lines as they are in a report (e.g., as temporary workspaces).  
Unchecked, any section of consecutive blank lines is condensed to only 
2 blank lines in the report.  When this button is selected by clicking on it, 
it appears set back or “pushed in.”  

Report Sets

 
Report Sets Window

Personalized Report Sets allow you to select more than one report, 
and save that group of reports under a convenient name.  

Selecting that named report set displays all the reports in that 
group, without having to select them one at a time.  Only one report set 
at a time can be displayed in the Reports Reference Box.

A list of available report sets (that you’ve created) appears at the 
bottom of the Select Report pop-up menu, under the category “Report 
Sets”.
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Create a Report Set

1.  Click on the Report Sets tile.  A report sets table displays, 
showing all available Dramatica reports grouped by category.  
To the right of each report name is a description of the report’s 
contents.  

2. Clear any reports currently selected by clicking on the Clear 
button.

3. Choose a report by clicking in the leftmost column next to its 
name.  A checkmark displays, indicating that it’s selected.

4. Choose one or more other reports in the same manner.  All 
your selected reports display checkmarks.

5. Click on the Save button.  A Save Report Set window displays.

6. Enter a descriptive name to save the report set with, and click 
OK to save it.  You are returned to the Reports Set window.

7. To return to the Select Reports window with your new report 
set selected, click on the OK button.  To return to the Select 
Reports window with no report set selected, click on the Clear 
button.

Select a Report Set
Select and display a personalized report set using one of these 

methods:
From the Select Reports window:
1. Click on the Select Reports pop-up menu.

2. Scroll down and click on one of your named report sets at the 
bottom of the list.

From the Choose Report window:
1. Click on the Report Sets tile.  The Report Sets window 

displays.

2. Click on the Select Report Set pop-up menu at bottom left of 
the window.

3. Scroll down and click on one of your previously saved report 
sets.  A checkmark displays next to your selected report set, 
and also in the leftmost column next to each report in that set.
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Delete a Report Set
To delete a personalized report set:
1. Click on the Report Sets tile.  

2. A Choose Report table displays, showing all available 
Dramatica reports grouped by category. 

3. Clear any reports currently selected by clicking on the Clear 
button.

4. Click on the Select Report Set pop-up menu at bottom left of 
the window.

5. Scroll down and click on a report set to select it.  

6. Click on the Delete button.

7. Click on the Yes button to confirm your deletion request.

Report Set buttons

 

Clear button
Click on this button to deselect the currently selected report or 

report set and clear its text from the Reports Reference Box.  

Delete button
Click on this button to delete the currently selected report or report 

set and clear its text from the Reports Reference Box.  

Save button
Click on this button to Save the currently selected reports to a 

named report set.  

Cancel button
Click on this button to exit the Report Sets window and discard 

any changes to the selected reports or report sets, including the Clear 
command.  Any Delete and Save commands you executed remain in 
effect.  
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OK button
Click on this button to exit the Report Sets window and save any 

changes to the selected reports or report Sets, including the Clear 
command.

Report Options tile

 

The Report Options tile displays the Report Options window of the 
Preferences command.  

Report Options:

• Printing Margins—Enter values for your report margins—Top, 
Bottom, Left, and Right—adjustable in units of 1/100th of an 
inch.

• Number of Columns—Select from: 1, 2, or 3 columns of text 
in your report.

• Header—Enter the text, along with Substitution codes and 
Justification codes, for the headers in Dramatica’s printed 
reports.  Header text displays left-justified, unless you indicate 
otherwise.

• Footer—Enter the text, along with Substitution codes and 
Justification codes, for the footers in Dramatica’s printed 
reports.  Footer text displays left-justified, unless you indicate 
otherwise.

Header/Footer Justification Codes

If you type: Dramatica justifies your text:

^< Left

^|  (“|” = shift-backslash) Center

^> Right
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Justification Codes affect the text directly to the left of them.  As an 
example, the default  footer text of:

Dramatica ^V^<- ^P -^|^D^>

prints as:

Dramatica 4.0 - 1 -  Mon Jan 3, 13:12:35 2000

Header/Footer Substitution Codes

If you type: Dramatica substitutes:

^A or ^a Author of story

^D or ^d Date and Time

^P or ^p Page number

^R or ^r Report name

^T or ^t Title of story

^V or ^v Version number of Dramatica

^^ The caret character (^)

Export to Screenwriter
The Export to Screenwriter command exports two kinds of 

information from Dramatica to Movie Magic Screenwriter (a full-featured 
word processing program for formatting scripts): 

• The Acts/Scenes/Chapters you created in the Storyweaving 
stage.

• Character information.
Specifically, these items are exported from Dramatica:
• Story title.

• Character names.

• Character descriptions.

• Scene names.

• Scene descriptions.

• Storyweaving story points and illustrations.
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To Export to Screenwriter:

1. Open the file you want to export from.

2. At the Dramatica Desktop, click on the Reports tile.

 -or-

 Under the Storytelling Menu, select Reports…

3. In the Reports window, click on the Screenwriter… tile.

4. At the Export to Screenwriter window, select a folder to 
save the export file to, and give it a name.  (In Windows, the 
Dramatica export file is given the extension .dsw.)  Click on the 
Save button.

A Dramatica export file is saved.

To Import from Dramatica into Movie Magic Screenwriter:

1. Open Movie Magic Screenwriter.

2. Under the File Menu, select Open.

3. At the Open File window, click on the Files of type: pop-up 
menu.  Scroll down the list and select Dramatica Exchange.  

4. If you’re importing a file exported from Dramatica for MacOS, 
select All Files (*.*).

5. If you saved the Dramatica export file to another folder, click on 
the Look in: window to browse for it.  When you find it, double-
click on it to load it. 

The following Dramatica scene and character information is loaded 
into a new Movie Magic Screenwriter file:

Story Title—loads as a Centered Title element, the first item in the 
Screenwriter file.

Character Name and Description—loads as an Action element, at 
the beginning of the file.

Character Name—loads into Screenwriter’s User List as a 
Character Name element.  Shows up for quick entry from pop-up menus 
by pressing TAB, and can be entered into your script by typing the first 
letter or two.

Scene Label—loads as a Scene Heading, or slugline, at the 
beginning of each scene.  Taken from the Storyweaving/Scene Creation 
part of the Query System.

Scene Description—loads as an Action element, describing the 
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activities occurring in a scene.  Taken from the Storyweaving/Scene 
Creation part of the Query System.

Story Point—loads as a Script Note element after its associated 
scene, to remind you of the thematic elements you’ve decided to include 
in that scene.  Illustrating, how you’ve decided to show that element in 
your story, is included.  Can be easily converted to an Action element 
to become part of the scene.  Taken from the Storyweaving/Scene 
Creation/This Scene Represents part of the Query System.

Export
The Export command exports the currently displayed report to a 

text file, which can be loaded into your word processing program for 
further development or revision.

To Export the currently selected report or report set:
• Click on the Export tile in the Reports Window

You will be asked to identify the file folder and path where you want 
the report saved, and to name the report.  Use standard conventions for 
naming this report.  You might want to include the date in the name to 
help you keep it separate from other versions.  

(Note:  Do not give this text file the same name as your Dramatica 
story file.  Give it a different name, to avoid overwriting the original file.)

Page/Print Setup
The Page Setup or Print Setup command opens your computer 

operating system’s standard printing setup dialog box.  Here you can set 
options specific to your selected printer.  

Access Page/Print Setup using one of these methods:
• Click on the Print Setup tile (Windows) or Page Setup tile 

(MacOS) in the Reports window.

• Under the File Menu, select Print Setup (Windows) or Page 
Setup (MacOS).

Print
The Print command opens the print dialog box, ready to send the 

currently selected report to your printer.  Select the number of copies to 
print, which page(s) to print, and other print session-related controls.  

Print your report using one of these methods:
• Click on the Print tile in the Reports Window.
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• Under the File Menu, select Print.

Print Preview
The Print Preview command displays your report onscreen, scaled 

to 50% of the printed page size.  In Print Preview, you can “sneak 
preview” your report to see how it will look on the page.  If you’re not 
satisfied with the look of the page, make adjustments in the Page Setup/
Print Setup or Report Options windows.  

Prev Page—Clicking on this button takes you to the Previous page 
in your report.

Next Page—Clicking on this button takes you to the Next page in 
your report.

Print Page—Clicking on this button sends the currently displayed 
Page of your report to the printer.

Close—Clicking on this button exits the Print Preview window and 
returns you to the Reports window.

Print Preview Scrollbar
To move quickly around your report, drag the vertical scrollbar at 

the right of the window:
• Up to move towards the beginning of your report.

• Down to move towards the end of your report.

Story Points…
The Story Points window presents your storyforming and illustrating 

information in a table format.  
Its advantage over the Query System is that it gives an overview of 

your entire story, offering quick and easy access to any area.  However, 
it lacks the Query System’s question and answer format and extensive 
help.

Access the Story Points window using one of these methods:
• Click on the Story Points tile on the Dramatica Desktop.

• Under the Storytelling Menu, select Story Points.
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Story Points Window

The Story Points table is divided into four columns:
• The Story Point column displays each important Dramatica 

topic or story point by name.  

• The Item column displays the item chosen to answer the 
Storyforming question posed by the story point.  (If your story is 
not down to a single storyform, nothing will be displayed in the 
Item column.)  

• The Definition column links the item and story point together 
by using the definitions of each term in a sentence.  

• The Illustrations column displays any examples you’ve written 
for the story point.

Navigating Story Points
Story Points is arranged in a table format, divided into sections 

by the categories of Genre, Theme, Plot, and Overview.  Each section 
displays in a different color.  

The Story Points table is divided into the these sections:
Genre Points
• Story Dynamics

Thematic Points
• Overall Story

• Main Character
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• Impact Character

• Main vs. Impact Story
Plot Points
• Central Plot Points

• Overall Story Type Order

• Main Character Type Order

• Impact Character Type Order

• Main vs. Impact Story Type Order
Overview Points
• General

• Audience Appreciations
Above the table area is a pop-up menu for moving directly to a 

specific section.  

Story Points Pop-Up Menu
Choose a story points section to work in from the pop-up menu at 

top left of the window.  The Story Points window jumps to that part of the 
table.

Scroll Bar
Move vertically through a particular story points section using the 

scroll bar on the right side of the Story Points window.  To move quickly 
between the section currently displayed, slide the scroll bar button up or 
down.

Edit Illustration
To edit the Illustration text:
• Double-click on a text box in the Illustrations column.

 -or-
• Click on a text box to highlight it, then click on the Edit 

Illustration button.  
The Edit Illustration window for that particular story point displays.  

Change or add to the text, as desired.
Exit the edit window by clicking on the OK button (to save your 

changes) or the Cancel button (to discard the changes).
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Set Font
To change the font and/or size for all the text displayed in the story 

points table:
1. Under the Edit Menu, select Set Font…  The Set Font window 

displays.

2. Select a font and/or size from your system’s available fonts.

3. Click on the OK button to apply the new font selection.
Any changes you make are applied to the text in all four columns.
To change the font and size for a specific column in the Story Points 

window:
1. Click on the column’s title (story point, item, definition, or 

illustration) to select and highlight it.

2. Under the Edit Menu, select Set Font…  The Set Font window 
displays.

3. Select a font and/or size from your system’s available fonts.

4. Click on the OK button to apply the new font selection.
The font and size for the other columns will remain unchanged.

Changing Column Widths
To change the column width for a specific column in the Story 

Points window:
1. Move the mouse over the column separator line in the area 

above the Story Points table (for example, over the line 
between item and definition).  The cursor changes to a split-
diamond shaped column cursor.  

2. Hold down the mouse button and drag the column separator 
left or right, until the columns have the desired width.  

3. Release the mouse button.

Plot Progression…
 Plot Progression gives you a linear view of your story’s 4 

throughlines, showing how the plot in each progresses over time.  
The 4 Signposts are indicators of where the characters stand at 

certain key points along their journey through the story.  
The 3 Journeys are dramatic acts, detailing the events the 
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characters must experience and deal with on their travels from one 
signpost to the next.

To view the signposts & journeys, use one of these methods:
• Under the Storytelling Menu, select Plot Progression…

• At the Dramatica Desktop, click on the Plot Progression tile.

 
The Plot Progression Window

For each throughline—Overall, Main vs. Impact, Main Character, 
and Impact Character—the signposts and journeys are laid out in a 
linear fashion, from left to right, as they progress through the story from 
beginning to end.  Each storyform throughline displays in a different 
color. 

Signpost Storyforming
Each field in a signpost colored field—such as Overall Story 

Signpost 1—contains a dramatic element assigned by you and 
Dramatica when you reached a single storyform.  

If you haven’t yet reached one storyform, you can assign dramatic 
elements here in the Plot Progression window:

1. Click on the name of the dramatic element (or “an unchosen 
item”) in the colored signpost field.  A pop-up menu of available 
elements displays. 

2. Click on an element to select it.
The 4 signposts of a particular throughline will always be one of the 

following groups:
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• The Past, How Things Are Changing, The Future, The Present

• Understanding, Doing, Obtaining, Gathering Information

• Visualizing a Plan, Playing A Role, Changing One’s Nature, 
Conceiving An Idea

• Memories, Impulsive Responses, Unconscious Desires, 
Contemplation

The other 3 throughlines will take the remaining 3 groups of 
signposts.  The order in which these elements occur as signposts is 
determined by the unique structure of your story.

Journey Storyforming
Each colored field in a journey column—such as under Overall 

Story/Journey 1—displays the two signposts that the journey is traveling 
between.  

Colored journey fields are not editable.  Their contents are 
determined by the signposts before and after them.

Resizing Plot Progression columns
At top left of the Plot Progression window are two directional 

buttons:
`<~ —Click on the left-pointing arrow button to decrease the width of 

all the columns, displaying more of the signposts & journeys onscreen.
`>~ —Click on the right-pointing arrow button to increase the width 

of all the columns, displaying less of the signposts & journeys onscreen.
Navigating the Plot Progression window
Move around in the Plot Progression window using the vertical and 

horizontal scrollbars, at right and bottom of the window respectively.
Use the TAB key to move between the signposts and journeys in a 

linear fashion, from left to right and top to bottom.
Use the ARROW KEYS keys to move from field to field.

Illustrations
To toggle the display of your story’s  illustrations on and off:
• Click on the Illustrations button at top left of the Plot 

Progression window.
Beneath each colored throughline, another row displays.  The 

writing you did in the illustrating stage displays in the field below each 
signpost and journey.  The fields in this row are blank if you haven’t 
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done any illustrating yet.  
To edit the illustrations:
1. Double-click on the field containing the text you want to edit.  

The Edit Illustration window displays.

2. Add, change, or delete text as desired.  Use the Cut, Copy, and 
Paste commands if needed.

3. Exit the Edit window by clicking on the OK button (to save your 
changes) or the Cancel button (to discard the changes).

Clear Storytelling…
Clear Storytelling permanently deletes all the illustrative text you’ve 

entered—in both Illustrating and Storyweaving—about your storyform.  
This includes removing any scenes, acts, or chapters you’ve created in 
Storyweaving.

You would only want to Clear Storytelling when you wish to keep 
the storyform, but would like to restart illustrating it from scratch, with a 
clean slate.

To Clear Storytelling:
• Under the Storytelling Menu, select Clear Storytelling…

Dramatica prompts you to confirm your irreversible decision to clear 
your illustrations.  There is no revert or undo command available for 
Clear Storytelling.  

Tools

Dramatica has a few specialized commands designed to augment 
your story creation and analysis experience.  These commands are on 
the Tools menu.

Dramatica Dictionary
Dramatica uses a large vocabulary of terms, many of which have 

meanings specific to Dramatica.  To help you understand them, they are 
available in a special Dramatica “floating” Dictionary.  Once opened, the 
dictionary can remain open in the background—always ready to jump to 
the foreground for your reference.
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The dictionary definitions displayed supplement the ones available 
in the Query System by clicking on the HelpView Definition button.  

To open the Dramatica Dictionary, select Dramatica Dictionary 
under the Tools Menu.

 
Dramatica Dictionary Window

At first glance, the Dramatica Dictionary window resembles the 
Dramatica Query System window.

Vocabulary List Tree
The Vocabulary List on the left side of the Dramatica Dictionary 

window shows you all the defined Dramatica vocabulary items.  
The Vocabulary List displays as a hierarchical tree.  Each 

vocabulary heading can be expanded to show the items nested beneath 
it, and collapsed to hide them.  

The look and feel of the vocabulary list are slightly different under 
Windows and MacOS:

Windows Vocabulary List
The tree works in a similar fashion to Windows 95’s Explorer 

program.  
• Clicking on the `+~ symbol expands the vocabulary heading 

and displays all the items beneath it.

• Clicking on the `-~ symbol collapses the vocabulary heading 
and hides all the items beneath it.

• Pressing ENTER takes you to the next topic or item.  
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MacOS Vocabulary List
The tree works in a similar fashion to the MacOS’s Hierarchical 

Menus and Folders.  
• Clicking on the 4 symbol expands the vocabulary heading and 

displays all the items beneath it.  

• Clicking on the 6 symbol collapses the vocabulary heading 
and hides all the items beneath it.

• Pressing RETURN takes you to the next topic or item.  

Display Order pop-up menu
To change the display order, select from the Display Order Pop-up 

Menu located just above the vocabulary list:
• Alphabetical Order—displays every item in the Dramatica 

dictionary in alphabetical order, without vocabulary headings.

• Classification—displays vocabulary items grouped under 
vocabulary headings.  These headings can be expanded and 
collapsed to show or hide the items grouped under them.

Display Options pop-up menu
To determine which text displays in the Dictionary Definition window 

at the right of the screen, select one or more items from the Display 
Options pop-up menu:

• Short Definition—displays a concise explanation of the 
selected item.

• Long Definition—displays a longer, more detailed explanation 
with examples.

• Dynamic Pair—displays the item dynamically paired with the 
selected item, e.g., Problem vs. Solution.

• Synonyms—displays a list of words with similar meaning to 
the selected item.

• Classification—displays how the item is classified in the 
Dramatica Theory of Story.  Some items fall under more than 
one classification.

Lookup button
To directly search for a Dramatica item you want defined:



67.

1. Click on the Lookup button.  

2. In the Search Dictionary window that displays, type in the word 
or partial word to search for.  

3. Click on the OK button.
In the case of a partial word, Dramatica displays the first word 

beginning with those letters.  If no item is found, Dramatica sounds a 
single beep.

Spin-the-Model… command
The “Spin-the-Model” Brainstorming tool is a random storyform 

generator.  By using it, you allow Dramatica to randomly pick one 
storyform for you out of the 32,768 possible.  It retains any storyforming 
choices you may have already made in the DQS, Story Engine, or Setup 
Main/Impact windows.  

It’s a fun way to explore the possibilities of your incomplete 
storyform—you pick the Storyforming elements that you’re sure of, then 
spin-the-model to have Dramatica pick the rest for you randomly.  

You can feel confident when spinning the model.  You won’t 
produce a story that doesn’t make sense.  Any storyform that Dramatica 
picks ensures that you have a consistent story.  The differences are in 
the way that story will be told—changing its effect on an audience.

(Note:  If you are down to a single storyform, spin-the-model will 
not work because there are no remaining choices to be made—there is 
nothing left to spin.)

Play spin-the-model using one of these methods:
• On the Dramatica Desktop, click on the Brainstorming tile.  At 

the Brainstorming window, click on the Spin-the-Model tile.

• Under the Tools Menu, select Spin-The-Model.
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The Brainstorming “Spin-the-Model” Window

The Display window to the right of the Brainstorming window 
displays your current storyform, showing storyforming choices you and 
Dramatica have already made.

Spin button
Click on this button to spin the model, and have Dramatica 

randomly fill in the missing elements of your storyform.  
The Story Engine settings for the resulting storyform are displayed 

in the Display window at right.  If they’re not what you have in mind for 
your story, spin again.

Revert button
Click on this button to display your storyform as it was when you 

first entered the Brainstorming window, before doing any spinning.

OK button
Click on this button to exit the Brainstorming window and accept the 

new storyform generated by spinning the model, replacing your original 
one.

Cancel button
Click on this button to exit the Brainstorming window and discard 

the random storyforms Dramatica presented you with, and stay with 
your original storyform.

(Note:  The first time you spin the model it will take a little while.  
Subsequent spins, however, are speedier.)
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Character Generator… command
The “Character Generator” Brainstorming tool is a random 

character generator.  
Have fun by allowing Dramatica to generate one or more 

characters, randomly determining their number, gender, names, icons, 
and character elements.  You can create all new characters, or modify 
your existing characters.

Access the Character Generator by using one of these methods:
• On the Dramatica Desktop, click on the Brainstorming tile.  At 

the Brainstorming window, click on the Character Generator 
tile.

• Under the Tools Menu, select Character Generator…

 
The Brainstorming Character Generator Window

The characters generated by Dramatica can be viewed and edited 
in the Character List and Casting windows.

On the right side of the Character Generator window are options for 
generating characters.

Number of new characters pop-up menu
Select from this pop-up menu to determine how many new 

characters you want to generate.  Choices are:  
• None—If selected, the Character Generator doesn’t generate 

any new characters.  Instead, it modifies the characteristics—
gender, name, icon, character elements—of existing 
characters.
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• Random—If selected, a random number—between 1 and 
14—of new characters are generated.

• 1 to 14—If selected, exactly the number of new characters you 
specify here are generated.

Modify Existing Characters checkbox
If checked, your existing characters are modified when you click 

on the Generate button.  Unchecked, your existing characters are not 
affected by the Character Generator.  To modify existing characters 
without modifying their gender, also select Off in the Gender Distribution 
pop-up menu.

(Note:  Selecting None in the Number of New Characters pop-up 
menu automatically checks this option.)

Gender Distribution pop-up menu
Select from this pop-up menu to determine how many characters of 

each gender to generate or modify.  Choices are:  
• Random—If selected, generates a random distribution of male 

and female characters.

• All Female—If selected, generates female characters only.

• Mostly Female—If selected, generates mostly female 
characters and a lesser number of males.

• Even—If selected, generates an equal number of male and 
female characters.  If an odd number of characters is selected, 
distribution is alternated between male, female, male, female, 
etc. until the selected number is reached.  The gender of the 
first character generated is taken from your selection of Default 
Character Gender in Preferences.  If Neutral is selected there, 
the Character Generator defaults to Male as its first choice.

• Mostly Male—If selected, generates mostly male characters 
and a lesser number of females.

• All Male—If selected, generates male characters only.

• Off—If selected, generates characters with the gender of 
your selection of Default Character Gender in Preferences.  If 
Modify Existing Characters is checked, existing characters will 
not have their gender modified.
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Assign Character Names checkbox
If checked, each generated character is given a name (appropriate 

to their gender) different from all other characters in your story.  Names 
are taken from public records, specifically from recent national birth 
registration records.  Unchecked, each new character is listed by 
number, e.g., Character #6.

Assign Character Icons checkbox
If checked, each generated character is randomly assigned a new 

character icons (appropriate to their gender).  Unchecked, generated 
characters are assigned the same generic, gender-appropriate icons.

Assign Character Elements checkbox
If checked, randomly assigns character elements to generated 

characters.  These character elements are normally assigned by you 
in the Build Characters window, and can be changed there.  Character 
element options are set by the:

• Distribution slidebar—Drag the slider left or right to 
determine whether your generated characters lean toward 
being Archetypes or Complex Characters.

• Honor Current Characteristics checkbox—If checked, 
existing characters retain the character elements you have 
assigned to them.  Newly generated characters are not given 
these elements, as they have already been assigned by you.  
Unchecked, character elements already assigned to existing 
characters may be given to new characters instead.

• Assign All Character Elements checkbox—If checked, all 
64 character elements are assigned to the combination of 
generated plus existing characters.  Unchecked, a random 
number of character elements are assigned to generated 
characters.

Generate button
Spins the model and generates or modifies characters.

Revert button
Undoes all character generation since opening the Character 

Generator window, and reverts to the Character List as it was then.
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Cancel button
Exits the Character Generator window and discards any characters 

generated since opening it.

OK button
Exits the Character Generator window and saves any characters 

generated since opening it.

Theme Browser…
Theme Browser is recommended for Advanced Users Only.
The Theme Browser displays a 3-dimensional view of your story’s 

dramatic elements, giving a bird’s-eye look at how they interconnect.  
Theme Browser allows you to approach storyforming from an 

opposite perspective to that taken in the Story Engine.  There, you 
answer topics by choosing from story points.  In Theme Browser, you 
take a story point and from a list of available topics, decide which one to 
attach it to.

Let’s say you decided to create a story where the Main Character’s 
Problem is in the area of Inequity.  

• Using the Query System, you would go to the Main Character 
questions and find the one that asked you to choose MC 
Problem.  Scrolling down the list of elements, you would select 
Inequity to assign it as MC Problem.  

• Using the Theme Browser, you would go directly to the Inequity 
element (you’d have to know where it was located, or browse 
to find it).  With the option Allow Storyform Changes checked 
(see Browser Function pop-up menu, below), you would scroll 
through the pop-up menu choices and select Main Character 
Problem to assign Inequity to it.

Taking this approach to storyforming requires a level of familiarity 
with Dramatica that is beyond the grasp of the beginning user.  For that 
reason, the Theme Browser is recommended for advanced users only.

(Note:  You cannot reach a single storyform using the Theme 
Browser only.  You must make other choices in either the Story Engine 
or Query System.)

Access the Theme Browser using one of these methods:
• At the Dramatic desktop, click on the Theme Browser tile

• Under the Tools Menu, select Theme Browser…
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The Theme Browser Window

The Theme Browser shows all of the dramatic elements possible 
for a storyform in Dramatica, arranged in a grid format.  A storyform is 
made up of these elements, though no single storyform contains all of 
them.  Rather, your selection from among them determines your story’s 
thematic emphasis and its impact upon an audience.

Navigating the Theme Browser
The grid of dramatic elements is arranged in layers.  Move around 

using the following commands:
• Click on a dramatic element to make it the current selection.

• Press CONTROL+UP ARROW (Win) or CMD+UP ARROW 
(MacOS) to move up one layer closer to the top layer (or click 
on the Zoom Out button).

• Press CONTROL+DOWN ARROW (Win) or CMD+DOWN 
ARROW (MacOS) to move down one layer closer to the 
bottom layer (or click on the Zoom In button).

• Move up, down, left, and right on the Theme Browser screen 
using the ARROW keys.

Browser Function pop-up menu
This menu lets you choose the Theme Browser’s display modes 
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and settings.  Options are:
Term Definitions—If selected, puts the Theme Browser in View 

Only mode.  No story file is selected.  Click on a dramatic element to 
see its definition in the Term Definitions box at the bottom of the Theme 
Browser window.

“Your Story”—If selected, the name of the story file you choose 
is checked off (which is “Your Story” in the case of a new unsaved file).  
Any storyform topics you have answered in other parts of Dramatica 
display below the name of the dramatic element they are attached to.  

Allow Storyform Changes—If selected, displays pop-up menus 
next to those dramatic elements that can be changed from the Theme 
Browser.  

Click on the 6 symbol next to an element to display its Story Points 
pop-up menu, then click on your choice to select it.  

If the element can be used for other topics, they remain on the 
menu and are available for selection.  When the element cannot be 
used anywhere else in the storyform, the pop-up menu will not be 
visible.

Show Signposts—If selected, also displays the signposts that 
certain elements can be attached to—in the same pop-up menu as 
Allow Storyform Changes.  The 4 signposts of a particular throughline 
will always be one of the following groups:

• The Past, How Things Are Changing, The Future, The Present

• Understanding, Doing, Obtaining, Gathering Information

• Visualizing a Plan, Playing A Role, Changing One’s Nature, 
Conceiving An Idea

• Memories, Impulsive Responses, Unconscious Desires, 
Contemplation

The other 3 throughlines will take the remaining 3 groups of 
signposts.  The order in which these elements occur as Signposts is 
determined by the unique structure of your storyform.

Color pop-up menu
The colors and shades of gray assigned to the various parts of 

the Theme Browser are designed to be visually pleasing, but have no 
functional meaning in Dramatica.  Experiment to find the most pleasing 
color scheme.  

If you find the different shades and colors distracting, select Solid 
Gray instead.   
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Zoom In
Click on this button to “step forward,” moving your view of the 

Theme Browser one layer closer to the bottom layer.

Zoom Out
Click on this button to “step back,” moving your view of the Theme 

Browser one layer closer to the top layer.

Navigation Tree

 

This “pyramid” graphic represents the different layers in the 
Dramatica model of story.  The currently selected layer is highlighted in 
blue.  

• The top layer is an overview level, showing all 4 Classes of 
throughline.

• The second layer represents a Throughline (e.g., Activity).

• The third layer moves down into one of these throughlines to 
the Type level (e.g., Obtaining).

• The fourth layer goes into that type to the Variation level (e.g., 
Morality).

• The bottom layer under a variation is the Element level (e.g., 
Faith).

Storyforms Remaining
As you make a single choice in one of your storyforms—your 

story’s throughline, for example—notice that the number of potential 
Storyforms Remaining (displayed at top right of the window) decreases.  

Navigation Grid

 

As you move down into the layers of the Theme Browser, there are 
more items than can display onscreen at one time.  To move sideways 



76.

to an area on the same layer, use the Navigation Grid.
The currently selected area is highlighted in blue.  
To move instantly to another area, click on its square on the 

Navigation Grid.  
Move up, down, left, and right on the Navigation Grid using the 

ARROW keys.

Help Commands

Help… command
 In addition to the Dramatica Dictionary, Dramatica has an 

extensive online help system.  
• User’s Manual contains the same information as the printed 

manual, for easy access while at the computer.  

• Dramatica Theory Book contains the entire text of the original 
Dramatica Theory book.  Terms used are those of the original 
theory, not the new layman’s terms used in this version of the 
software.

Access the online help system using one of these methods:
• At the Dramatic Desktop, click on the Help tile.

• Under the Help Menu, select Help Topics… (Windows only).

• Under the  Menu, select Dramatica Help System… (MacOS 
only).
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Help Topics window

The Help Topics window offers three options on clickable tabs:

Contents
The help system opens up in this window.  Double-click on the 

User’s Manual book icon or the Dramatica Theory Book icon to open up 
the chapters nested beneath it.  Double-click on the book icon of one of 
these subjects to display its contents.

Index
Click on this Tab to display help’s alphabetical Table of Contents.  

Type the first few letters of the word to find, and the index jumps straight 
to the first subject starting with those letters.  Double-click on the subject 
to display its help contents.

Click on Help Topics on the menu bar to return to where you left off, 
or Back to display the previous help window you viewed.

Find for Windows
The first time you select the Find tab in Windows, you are prompted 

to generate an index of all the words in the Help system.  The minimized 
index is sufficient for most purposes.  Once the alphabetical list of words 
displays, you’re ready to find your help topic.

• Type the first few letters of the word to search for.  The help 
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system highlights the words beginning with those letters.

• Select one of the search words by clicking on it.  The topic list 
at the bottom of the window shortens.  

• Double-click on a topic to display its contents.

• Click on the Help Topics menu item to return to the Find index.
Clear—Click on this button to clear any letters you’ve typed and 

start over.
Options—Click on this button to display further search criteria.  

Select from the pop-up menus and click on the checkboxes as 
appropriate.  

Rebuild—Click on this button to generate the searchable index of 
words again.

Find for MacOS
Selecting the Find tab in MacOS does not generate a word list.  

Instead, the Find feature searches the Help files and returns a list of the 
results.  

• Select find criteria from the pop-up menus

• Type the first few letters of the word to search for.  

• Click on the Search button.  The Find feature highlights the first 
topic containing those letters.

• Double-click on a topic to display its contents.

• Click on the Help Topics menu item to return to the Find 
window.

More Choices—Click on this button to display more find criteria 
pop-up menus and narrow your search.

Options—Click on this button to display further find criteria.  
Select from the pop-up menus and radio boxes and click on 
the checkboxes as appropriate.
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